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Introduction to Epson Projector Professional Tool
See the information here to learn more about the Epson Projector Professional Tool software.
Epson Projector Professional Tool Features

Epson Projector Professional Tool Features
The Epson Projector Professional Tool allows you to adjust and control images projected from network
projectors using your computer.
Adjustments to Projected Image Layout
Lens Control Feature
Geometric Correction Feature
Edge Blending and Color Uniformity Features
Projector Operations or Settings
Apply Settings to Multiple Projectors Simultaneously
Parent topic: Introduction to Epson Projector Professional Tool

Adjustments to Projected Image Layout
You can adjust the layout of projected images by visually selecting the projector on your computer
screen.

Parent topic: Epson Projector Professional Tool Features
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Lens Control Feature
You can adjust the focus or the position of the lens installed on the projector.

Parent topic: Epson Projector Professional Tool Features

Geometric Correction Feature
You can correct image distortion when projecting on a curved or right-angled screen using the
Geometric Correction feature.

Parent topic: Epson Projector Professional Tool Features

Edge Blending and Color Uniformity Features
You can create a single seamless image from multiple projectors using the Edge Blending feature, and
you can reduce color tone differences between images using the Color Uniformity feature.

Parent topic: Epson Projector Professional Tool Features
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Projector Operations or Settings
You can control the basic projector operations such as turning the power on or off, and displaying a Test
Pattern from your computer screen.
You can also select projector settings necessary for the projector installation.
Parent topic: Epson Projector Professional Tool Features

Apply Settings to Multiple Projectors Simultaneously
You can apply the following settings to multiple projectors:
• Power/Source
• Shutter
• On Screen
• Test Pattern
• All features in Initial Setting tab
• All features other than Edge Blending in Image tab
Parent topic: Epson Projector Professional Tool Features
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Setting Up the Software for the First Time
Follow these instructions before connecting a computer to the projector over a network.
Installing the Software

Installing the Software
Note:
• If the language selected for the installation differs from the language of the operating system being
used, the screens may not display correctly.
System Requirements
Installing the Epson Projector Professional Tool
Parent topic: Setting Up the Software for the First Time

System Requirements
Your computer must meet the following system requirements to use the Epson Projector Professional
Tool software.
Requirement

Windows

Operating system

Windows 7
• Ultimate (32- and 64-bit)
• Enterprise (32- and 64-bit)
• Professional (32- and 64-bit)
• Home Premium (32- and 64-bit)
• Home Basic (32-bit)
Windows 8.1
• Windows 8.1 (32- and 64-bit)
• Windows 8.1 Pro (32- and 64-bit)
• Windows 8.1 Enterprise (32- and 64-bit)
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Requirement

Windows
Windows 10
• Windows 10 Home (32- and 64-bit)
• Windows 10 Pro (32- and 64-bit)
• Windows 10 Enterprise (32- and 64-bit)

CPU

Intel Core2Duo 1.2GHz or faster
(Intel Core i3 or faster recommended)

Memory

1GB or more
(2GB or more recommended)

Display

Resolution between 1280 × 768 and 1920 × 1080

Parent topic: Installing the Software

Installing the Epson Projector Professional Tool
Download and install the Epson Projector Professional Tool on your computer.
Visit epson.com/support (U.S.) or epson.ca/support (Canada) and select your projector to download the
latest version of the Epson Projector Professional Tool.
Note:
• You need administrator authority to install the Epson Projector Professional Tool.
1. Download the latest version of the Epson Projector Professional Tool.
2. Double-click EPPT_Setup.exe to start the installer.
3. Follow the on-screen instructions.
Parent topic: Installing the Software
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Creating and Adjusting Projector Projects
Follow these instructions to create a projector project, register projectors to the project, and adjust the
image layout.
Creating a Project
Adding a Projector to a Project
Adjusting the Layout of the Projector Panel

Creating a Project
You can save projector connection information and the layout of the projected image as a project.
Creating separate projects allows you to save projector settings depending on the installation
environment.
When you start the Epson Projector Professional Tool, the following screen is displayed.

• Select New Project to create a new project to register projectors you want to control.
• Select Open Project to open the previously created project.
Attention:
• If you change your computer's network adapter settings before starting the Epson Projector
Professional Tool, the software may not start. Restart your computer first.

10

• This software uses a MAC address to identify each projector. Do not change the MAC address after
creating a project.
Note: To change the language or color theme for the software, select
select the Option setting.

in the upper right corner and

When you create a project, the software automatically searches for network projectors on the same
subnet and displays up to 50 detected projectors as panels on the Layout tab.

Each projector panel contains the following information and updates automatically every 30 seconds:
• Projector name
• IP address
• Projector status
Parent topic: Creating and Adjusting Projector Projects

Adding a Projector to a Project
Select the projector panel you want to add to the project and select the following buttons as necessary.
Note: You can select multiple projectors in the following way:
• Select multiple projector panels by dragging them on your computer screen.
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• Select each projector panel by pressing Ctrl + [Enter/Space] on the keyboard. (You can select and
deselect a projector panel by pressing the [Enter/Space] button each time.)

1

Edit Group

Sets up projectors in a group so you can control them simultaneously.
• Group: Creates a group of the projectors you selected.
• Ungroup: Removes the selected projector from the group.
• Rename Group Name: Lets you edit the name of the projector group.

2

Save

Saves the projector information and the layout of the projector panel to the
project file.

3

Add Projector

Adds a projector manually by specifying the projector's IP address.

4

Refresh

Updates the projector information.
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5

Edit

Adjusts the projector's settings.
• Rename Projector Name: Lets you edit the name of the selected
projector.
• Remove: Deletes the projector from the project.
• Authentification: Performs authentication manually when the projector
status is Not Authenticated. If you set the same password for multiple
projectors, you can perform authentication for multiple projectors at one
time by selecting multiple projector panels before selecting this button. If
you set the default Web Control password for the projector, the projector
is automatically authenticated.

6

Power/Source

Controls the projector power, input source, and shutter settings.

7

Projection Info

Displays the IP address and the name of the projector you selected.

Parent topic: Creating and Adjusting Projector Projects

Adjusting the Layout of the Projector Panel
You can change the layout of the projected images by dragging and dropping the individual projector
panels on your computer screens. When you select multiple projector panels, you can move them at one
time.
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When you have finished making adjustments of the layout, select the Save button to save the project.
Note: When you want to group projectors so you can control Screen Matching, make sure you set the
panels under the following conditions:
• All the projectors must support Screen Matching.
• There are no gaps between the panels.
• The shape of the selected panels forms a rectangle.

Parent topic: Creating and Adjusting Projector Projects
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Adjusting Projected Images
See the following sections to select and adjust individual projector settings on the Epson Projector
Professional Tool Setting tab.
Projector Adjustment Options on the Software Screen
Screen Summary

Projector Adjustment Options on the Software Screen
When you select the Setting tab, the following screen is displayed.
Select the projector you want to adjust from the list in the lower left corner of the screen. Then adjust the
settings for that projector.

The following controls can apply to multiple projectors:
• Power/Source
• Shutter
• On Screen
• Test Pattern
The following table describes the types and usage of main buttons on the Setting tab.
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Adjust the value of settings. Select and hold the button to continue
adjustments until you release the button. You can also adjust the settings
by moving the

button.

Adjusts each value on the Setting tab by entering the number.
Selects a value from the options.

Turns the setting on or off, or displays additional instructions or
information.
Attention:
• Do not adjust your projected image using the projector remote control or control panel at the same
time that you adjust the image with this software. The settings displayed by the software may not
reflect the actual settings. To update the displayed setting values, switch to a tab other than Setting,
and then select the Setting tab again.
• Depending on the projector’s status, the setting values may not be displayed on this software screen.
• If communication with the projector fails and the projector cannot receive the setting values you
selected, the settings return to their original values.
Note:
If you want to adjust projector menu settings that cannot be set from this software, use the Epson Web
Control software. To access Epson Web Control, double-click the projector panel, select the Advanced
option, and then log in with the user name and password below.
User name is EPSONWEB; default password is admin.
Parent topic: Adjusting Projected Images

Screen Summary
See the sections here to adjust the settings available on each tab of the Setting tab. See your projector
User's Guide for details on the settings available for your projector.
Lens Control
Initial Setting
16

Edge Blending
Geometric Correction
Image
Black Level
Blanking
Parent topic: Adjusting Projected Images

Lens Control
You can adjust the projector's lens settings on the Lens Control tab.

Depending on the type of lens you installed, the available features or adjustment ranges may vary.
Note:
• When adjusting the image height with the vertical lens shift, adjust it by moving the image from the
bottom to the top. If you adjust it from the top to the bottom, the image position may move down
slightly after adjusting.
• For best results, adjust the Focus, Zoom, or Lens Shift settings only after projecting an image for 20
minutes or more. This gives the image a chance to stabilize before you adjust it.
Parent topic: Screen Summary
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Initial Setting
You can select the initial values for the following projector settings on the Initial Setting tab:
• Projection
• Light Source Mode
• Standby Mode
• Indicators
• Brightness Level
• Sleep Mode
• Standby Confirmation

You can adjust the settings for multiple projectors or groups on the Initial Setting tab. If you select
different projector models, you can adjust only settings that are available on all selected projectors.
Note:
• When you set Constant Brightness to On, you cannot change Light Source Mode settings. Doubleclick the projector panel and change the settings in the Epson Web Control screen.
• You can change the Brightness Level settings only when you set Light Source Mode to
Customized.
• When you reset all settings using Reset All, the following settings are not reset:
• Input Signal
18

• Memory
• User's Logo
• All settings on the Network menu
• Language
• Date & Time
• LCD Alignment
• Color Uniformity
• Lens Calibration
• Color Calibration
• Projector Grouping
• Screen Matching
• Color Matching
Parent topic: Screen Summary

Edge Blending
You can use the adjustments on the Edge Blending tab to create a single seamless image from multiple
projectors. Adjust the values to overlap the image sides as necessary.
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When you adjust the Top/Bottom/Left/Right Edge, Start Position, or Range settings, set Edge
Blending to On.
Note: Before using the Edge Blending settings, select the Image tab and select Multi-Projection as the
Color Mode setting to allow for more precise edge blending.
Parent topic: Screen Summary

Geometric Correction
You can correct image distortion using the settings on the Geometry Correction tab.

You can use the Curved Surface, Corner Wall, and Point Correction adjustments along with other
correction settings.
When you perform Point Correction, you can change the grid color of the projected pattern by selecting
the Pattern Color option. You can select and move up to 34 points simultaneously by dragging and
dropping them.
When you perform the Quick Corner, Curved Surface (Correct Shape), or Corner Wall (Horizontal
Corner, Vertical Corner), you can also make adjustments by dragging and dropping a point on your
computer screen.
Note:
• If you adjust the image using many different settings, the focus may not be uniform.
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• When 4K Enhancement is activated or 4K signal is input, you cannot use Curved Surface, Corner
Wall, or Point Correction.
• When you adjust the Linearity setting in the Curved Surface correction, you may not be able to adjust
the correction point to the maximum depending on other selected correction settings.
• You can register up to three Memory settings in each projector.
Keyboard Shortcuts
When you adjust settings on the Geometry Correction tab, you can use the following keyboard
commands:
Keyboard command

Function

Tab

Moves the cursor to the next point or edge of the image.

Shift + Tab

Moves the cursor to the previous point or edge of the image.

↑/↓/←/→

Moves the cursor on the point or edge of the image in the up, down, left,
or right direction.

Shift + [↑ / ↓ / ← / →]

Selects multiple points.

Esc

Deselects the cursor on the point.

1M 7 (Num)

Selects how much you want to adjust at one time.

Ctrl + [↑ / ↓ / ← / →]

Adjusts the point using the increment you selected using the 1 to 7
number keys. (Press and hold the buttons to adjust more quickly.)

Ctrl + Shift + [↑ / ↓ / ← / →]

Adjusts the point by one step. (Press and hold the buttons to adjust
more quickly.)

Alt + [↑ / ↓ / ← / →]

Adjusts the point by 10 steps. (Press and hold the buttons to adjust
more quickly.)

Ctrl + [← / →]

Adjusts the edge of the image.

i

Initializes the point settings.

Alt + s

Registers the Memory settings.

Alt + l

Loads the Memory settings.

Parent topic: Screen Summary
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Image
You can adjust the following image settings on the Image tab.
• Color Mode
• Light Source Mode
• Brightness Level
• Dynamic Contrast
• Image Processing
• Frame Interpolation
• Deinterlacing
• Brightness
• Contrast
• Color Saturation
• Tint
• RGBCMY
• White Balance
• Color Uniformity
• Blend Curve
You can also perform the following automatic corrections on the projector or group you selected:
• Screen Matching
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• Color Calibration

When using the Pattern Display feature to adjust the Color Matching settings in this software, you can
select the pattern type you want to view to confirm your settings.
• Tone Pattern displays a smooth image with gradations applied to the overlapped image area.
• Blend Pattern clearly displays the center of the overlapped image area.
You can adjust the settings for multiple projectors or groups simultaneously on the Image tab. If you
select different projector models, you can adjust only settings that are available on all selected
projectors.
Note:
• When adjusting the RGBCMY, Color Matching, and Color Uniformity settings for a projector group,
you must apply the settings to all projectors in the group.
• When adjusting the Color Uniformity settings, the image may become distorted. The image is
restored once adjustments are complete.
• When you set Constant Brightness to On, you cannot change the Light Source Mode setting and
the Brightness Level settings.
• You can change the Brightness Level settings only when you set Light Source Mode to
Customized.
• You can change the Dynamic Contrast settings only when you set Color Mode to Dynamic or
Cinema.
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• You can change the Image Processing-Fast 1 settings only when you set Deinterlacing to Video or
Film/Auto.
• You cannot change the Frame Interpolation settings in the following situations:
• The input signal is higher than WUXGA.
• 4K Enhancement and Scale are enabled.
• Edge Blending is set to On.
• Image Processing is set to Fast 1 or Fast 2.
• You cannot change the Deinterlacing settings in the following situations:
• Image Processing is set to Fast 2.
• The input signal is other than 480i, 576i, or 1080i.
Operating conditions for automatic correction
You can perform automatic correction in the following situations:
• The automatic correction is available in all projectors in a group.
• All projector panels in a group are positioned with no gaps and formed in a rectangular shape.
• The screen surface is flat and not skewed or warped.
• A matte white diffusion screen is used.
• The projection size is from 80 to 200 inches.
• After you perform Tiling, the projected image is formed in a rectangular shape.
• All projected images are lined up with no gaps. (Adjust the width of the overlapping area to 15 to
45% .)
• The projector is installed parallel to the projected image.
Note:
• Automatic correction may not be performed depending on the projector lens. See your projector User's
Guide for details.
• After you perform automatic correction, the adjustment range of the lens shift may be reduced,
depending on the projector lens.
• We recommend performing automatic correction after turning on the projector or canceling Shutter for
20 minutes or more.
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• When you project images or make adjustments, we recommend darkening the room for the most
accurate corrections.
• When you perform automatic correction using the camera built into the projector, do not block the
camera or the projected images.
Parent topic: Screen Summary

Black Level
You can adjust the brightness and color tone for the area where the images do not overlap to create a
seamless image.

Note:
• When you turn off Edge Blending or have not selected the edge of the image, you cannot adjust the
Black Level setting.
• When multiple screens are overlapping, adjust based on the area with the most overlap (the brightest
area).
• You cannot adjust the Black Level setting when a test pattern is displayed.
• If the Geometry Correction value is large, you may not be able to adjust the Black Level setting.
• If you change the Top Edge/Bottom Edge/Right Edge/Left Edge settings, the Black Level setting
returns to its default value.
• During automatic Screen Matching adjustments, previously selected Color Adjustment settings may
change.
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Parent topic: Screen Summary

Blanking
You can hide a specific area of the projected image you select.

Note: When no input signal is received, you cannot adjust the Blanking settings.
Parent topic: Screen Summary
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Appendix
See these sections to learn more about the Epson Projector Professional Tool software.
Updating and Uninstalling the Software
Notices

Updating and Uninstalling the Software
Follow these instructions to uninstall the Epson Projector Professional Tool.
Getting the Latest Version of the Application
Uninstalling Epson Projector Professional Tool (Windows 7)
Uninstalling Epson Projector Professional Tool (Windows 8.x/Windows 10)
Parent topic: Appendix

Getting the Latest Version of the Application
Updates to this software and this manual may be available for your product. To check for updates, visit
epson.com/support (U.S), epson.ca/support (Canada), or epson.com.jm/support (Caribbean) and select
your product.
Parent topic: Updating and Uninstalling the Software

Uninstalling Epson Projector Professional Tool (Windows 7)
Follow the instructions below to uninstall Epson Projector Professional Tool.
Note: You need administrator authority to uninstall the software.
1. Turn on your computer.
2. Make sure all running applications are closed.
3. Click Start, and then click Control Panel.
4. Click Uninstall a program from the Programs category.
5. Select Epson Projector Professional Tool, and then click Uninstall/Change.
6. Follow the on-screen instructions.
Parent topic: Updating and Uninstalling the Software
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Uninstalling Epson Projector Professional Tool (Windows 8.x/Windows 10)
Follow the instructions below to uninstall Epson Projector Professional Tool.
Note: You need administrator authority to uninstall the software.
1. Turn on your computer.
2. Make sure all running applications are closed.
3. Press the

key on the keyboard to display all apps.

4. Right-click (press and hold) Epson Projector Professional Tool Ver.X.XX, and then select
Uninstall.
5. Follow the on-screen instructions.
Parent topic: Updating and Uninstalling the Software

Notices
Check these sections for important notices about your software.
Copyright Notice
About Notations
General Notice
Copyright Attribution
Parent topic: Appendix

Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. No patent liability is assumed with
respect to the use of the information contained herein. Neither is any liability assumed for damages
resulting from the use of the information contained herein.
Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third
parties for damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this
product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.
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Seiko Epson Corporation shall not be liable against any damages or problems arising from the use of
any options or any consumable products other than those designated as Original Epson Products or
Epson Approved Products by Seiko Epson Corporation.
The contents of this guide may be changed or updated without further notice.
Illustrations in this guide and the actual projector may differ.
Parent topic: Notices

About Notations
• Microsoft® Windows® 7 operating system
• Microsoft® Windows® 8.1 operating system
• Microsoft® Windows® 10 operating system
In this guide, the operating systems above are referred to as "Windows 7", "Windows 8.1", and
"Windows 10". Furthermore, the collective term Windows may be used to refer to Windows 7, Windows
8.1, Windows 10, and multiple versions of Windows may be referred to as, for example, Windows 7/8.1,
with the Windows notation omitted.
Parent topic: Notices

General Notice
EPSON is a registered trademark, and EPSON Exceed Your Vision is a registered logomark of Seiko
Epson Corporation.
Microsoft, Windows, and Windows logo are trademarks or registered trademarks of Microsoft
Corporation in the United States and/or other countries.
Other product names used herein are also for identification purposes only and may be trademarks of
their respective owners. Epson disclaims any and all rights in those marks.
Software Copyright: This product uses free software as well as software to which this company holds the
rights.
© 2017 Epson America, Inc.
Parent topic: Notices

Copyright Attribution
12/17
CPD-54926
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Parent topic: Notices
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